Chapter 2							


Introduction to PFGMH


Benefits of PFGMH


Whether you are an owner, a developer, or an architect/engineer working for an owner, PFGMH will provide a powerful assistance in the preparation of the Worksheets necessary for application of an FHA mortgage. PFGMH will rapidly determine the gravity and lateral loads to apply to the preferred Manufactured Housing Unit, and quickly assess the permanent foundation requirements for connection to the unit superstructure. PFGMH allows the user to perform all the tasks contained in the Permanent Foundation Guide  for Manufactured Housing, HUD Handbook 4930.3-REV-2; hereafter referred to as the “Handbook”.


PFGMH is arranged to mirror the procedures of the “Handbook” and eliminate use of  the Appendix B charts, which of necessity were formulated on many simplifying assumptions and are therefore conservative. The results from PFGMH will be exact, based on the user’s input values into the program and will be in accordance with the requirements of ASCE 7-93 - Minimum Design Loads for Buildings and Other Structures.  The main features of the program include:


Uses exact dimensions and loads based on ASCE 7-93, including wind and seismic forces to compute required reactions to be resisted by the permanent foundation.


Determines footing sizes for various foundation Types and allowable soil bearing pressures.


Determines anchorage requirements between foundation and superstructure to resist overturning in the transverse direction and sliding in both the transverse and longitudinal directions.


The Owner’s Site Acceptability Worksheet, Manufacturer’s Worksheet and the Design Worksheet can be easily filled out on the screen and printed with many of the values automatically entered. 


Draws the various graphical views of the foundation system selected in 2-D plan view , transverse and longitudinal section views, plus a 3D perspective.


Displays the superstructure with graphical views of dead, live or snow, wind and seismic loads as selected by the user.


Provides an on-line version of the Handbook with hypertext links for easy navigation.


Provides an easy to use Windows interface with on-line Help.


Provides the maps on-screen necessary to make decisions related to geographic location.


Provides graphical display of each foundation type and its typical details as drawn in Appendix A of the “Handbook”.


Provides on-line graphical tables of capacities to aid selection of  components and fasteners for details to resist overturning and sliding based on the foundation type selected.


Open PFGMH


In the Program Manager window, double click the PFGMH icon. A PFGMH window will open with several icon options. Double click the PFGMH icon of a house cross-section and the program will start with the PFGMH Graphics window as follows:
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Understanding PFGMH Views


Four views of a generic manufactured home superstructure appear in the PFGMH Program Window. Once a foundation system is eventually selected the emphasis will be on the views of the foundation system and the superstructure views will fade. Thus eventually the upper right quadrant will become a foundation plan, the right lower quadrant will become a longitudinal foundation section cut through a chassis beam or a marriage wall, the lower left quadrant will become a transverse section through the foundation. The upper left quadrant will be a perspective of the foundation that can be viewed from any orientation by use of the View Tool Bar. 


To maximize any one of the four views, place the mouse pointer at the intersection of the View Separator Lines. Hold the left button down and drag the mouse on a diagonal to move the Lines to enlarge the desired view. For example, to maximize the perspective view drag the mouse diagonally to the lower right until the desired size is obtained. The screen image will look as follows: 
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	This process can be repeated to isolate and enlarge any of the four views. 








Understanding the Toolbars


View Toolbar


Only the perspective view is dynamic and can be manipulated by means of the View Toolbar situated in the upper left quadrant of the screen containing the perspective view. It is enlarged below to reveal its options
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Use the mouse pointer to grab the Distance Slider Bar and , while holding the left mouse button down, drag the bar to the right to bring the perspective view closer, or drag the bar to the left to push the perspective view farther away.


Use the mouse pointer to grab the Height Slider Bar and , while holding the left mouse button down, drag the bar up to view the unit from above, like a “bird’s eye view”, or drag the bar down to look under the unit, like a “worm’s eye view”.


Use the mouse pointer to grab the arrowhead on the 3D View wheel, while holding the left mouse button down, drag the arrow around 360 degrees to obtain the desired view of the superstructure and/or its foundation.


The icons that comprise the View Commands area, when selected by the mouse pointer and clicking the left mouse key, will illustrate the various loads that have already been assigned to the unit, such as dead, live, snow, wind and seismic. The icons are quite self-descriptive.


The Close button in the upper left hand quadrant of the View Tool Bar will remove the Tool Bar from the screen. The Tool Bar can be retrieved from the View Pull-down Menu, described below, by placing the mouse pointer on the words “Tool Bar” and clicking the left mouse key.


Pull-Down Menu bar
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File Pull-Down Menu


The File pulldown menu is typical of most Windows based software. it includes issues related to:


Operations with the files, such as:	New, Open, Close, Save, and Save As


Operations related to Printing, such as:	Print, Print Preview, and Print Set-up 


	Printing of graphics is limited to the four views shown on the program window, which may include any of the load cases selected for viewing. Select the view to be printed by clicking the mouse pointer on that view. Then select the print icon or print from the File pull-down menu. A print dialog window will appear, select OK and the view will print. See Appendix A and B, pages 133 to 136 for sample graphics that may be printed.


	Printing of the Worksheets: Select any Worksheet, then the print Icon, and a print dialog window will appear. Select the pages for printing, select OK and those pages will print. 


List of most current files accessed


Exit the PFGMH program


View Pull-Down Menu


The View Pulldown Menu from the Main Tool Bar provides another way to accomplish the same tasks as described above. The mouse can be used to open the View Pulldown Menu. Hold the left mouse key down and drag to the desired item in the list. For example the following partial screen illustration shows that the View Toolbar is not being shown and that transverse wind loads with positive internal pressure is illustrated in the transverse section of the superstructure. The check (() marks indicate which options are active. Note that there is no check in front of the view bar, which is currently missing from the screen. The icon corresponding to the “Show Transverse Wind Load, Gcpi Pos.” should appear indented to indicate that it has been selected for viewing. This accounts for the check mark shown on the pulldown menu.
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The remaining pulldown menus will only be introduced here, and discussed in more depth in Chapter 3, as the commands apply to example problems. The entire pull-down menu bar along with the Main Tool Bar of icons is illustrated below:





Geometry & Loads Pull-Down Menu


The Geometry & Loads pulldown menu has a list of commands. Hold down the left mouse key and slide the pointer to the desired command. Each command brings up a dialog window that assists the User to select: 


Superstructure Dimensions: Allows the User to establish the pertinent dimensions of the superstructure of the single or multi-wide unit. This is easily accomplished by typing in the numbers in the appropriate windows or by using the scroll box of typical values and making selections with the mouse pointer.





Foundation Design Concepts: Allows the User to select the appropriate Foundation system based on support and anchorage locations consistent with the manufacturer’s superstructure design. Also, indicated are recommendations if each foundation system is appropriate for high wind, high seismic, or deep frost protection requirements.





Dead Loads: The dialog window for dead loads on the Superstructure has four Tabs to select floor, roof, exterior wall or marriage wall for the creation of each item’s dead load. Position the mouse pointer on the desired component and click the left mouse key to view that component’s window. The selection of another Tab permits switching easily to another component’s window. Down-arrow buttons reveal drop-down list boxes of pre-set material dead load values that can be selected by use of the mouse pointer and clicking the left mouse key. This is another option, which avoids typing in the desired values.





Floor & Attic Live Loads: The typical floor live load is set at a default of 40 psf; however, it can be changed as desired by the User by holding down the left mouse key and graying over the present value and typing in the new value. The attic live load is only required if the roof slope permits space for an attic. The default is set to  zero, but any value can be typed in as described for the floor live load. A reasonable choice is 10 psf when an attic is assumed.





Roof Live Load: The dialog window indicates that snow load or a minimum roof live load based on the roof slope must be compared and the larger value used for design. The User can click the left mouse button when the mouse pointer is on the map button to review the Snow maps for the geographic location of the building site and read the isobar value for ground snow load in psf. Return to the Roof Live Load dialog box and use the mouse pointer to manipulate the scroll box to find the snow load magnitude, which will then be inserted without typing. The snow load equation includes other factors that are set as default values. These can be changed or the code provision can be selected for additional information about that factor by clicking the left mouse key when the mouse pointer is on the adjacent box. Whether the roof is slippery or the site is in Alaska is selected by clicking the left mouse button when the pointer is in the correct box. An “X” will verify your choice. The snow load equation is calculated and the magnitude is displayed. This value is compared against the minimum live load for the chosen roof slope and the larger of the two values is displayed and used for design.





Wind Load: The dialog window is similar in layout to that for snow load. The User reviews the Wind maps for the geographic location of the building site and reads the isobar value for wind speed in MPH. Return to the Wind Load dialog box and use the mouse pointer to manipulate the scroll box to find the wind load magnitude, which will then be inserted without typing. The procedure is then much the same as for snow loads. Magnitudes of wind load on all the superstructure surfaces are tabulated in the transverse and longitudinal directions.





Seismic Load: The dialog window starts with a summary of the dead and snow loads already calculated at the top. Any of these values can be changed by the procedures described for the other dialog windows. The user must review the seismic maps to find the Aa and Av values for the county where the site is located. All the remainder of the seismic coefficients are default values, that can be changed if desired. The seismic base shear is calculated and then that force is distributed to the roof and floor planes.


Worksheets Pull-Down Menu


The Worksheets pulldown menu includes the commands to access the three worksheets required for submission to HUD for approval of FHA mortgage insurance. These Worksheets are intended to assist the User in the completion of the forms. Information that has already been inputted or calculated will automatically be inserted into the worksheets to facilitate their completion. Information from the Owner’s and Manufacturer’s Worksheets are automatically entered into the Design Worksheet; however, the data entered or changed in the Design Worksheet does not update the Owner’s or Manufacturer’s Worksheets. It’s a one way process. 


Note:	Always fill out the Owner’s and Manufacturer’s Worksheets first.


Owner’s Site Acceptability Worksheet: This form window is of the scroll type with the up/down arrows along the vertical right side of the screen. The user types in his name, address, telephone, site location and legal description of the site in the same fashion as for most word processors. The remainder of the worksheet is a series of questions with yes/no choices. Click the left mouse key when the pointer is on the appropriate response. The response will highlight with a black border. References that are in green and also underlined in green refer to segments of the “Handbook” that pertain to the question being asked. If the user wants to read the text to better understand the issue, click the left mouse key when the pointer is on that green reference and The On-Line “Handbook” will appear with the selected reference.





Manufacturer’s Worksheet:  This form window functions similar to the previous Worksheet. A portion of the form window is shown to clarify several new functions. The Manufacturer starts by typing their Company Name, Address and Telephone Number. This portion works just like a typical word processor. 


	


A.	The Manufacturer then selects the Type of Unit by placing the mouse pointer over  the boxed choices, Single or Multi-section, and clicks the left mouse key. As illustrated the single section unit has been selected.
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B.	The Manufacturer then must for question #2, select the Method, Location and Type of Supports, and for the next group of questions, the proportions of the unit. This is done interactively with several other dialog windows.





C.	Click the left mouse key with the pointer over the right side box of question #2 and the Foundation Design Concept dialog window will appear. Consistent with the answer to question #1, the foundation options for a single-section unit appear. The page up/page down keys allows the User to scroll through more options. The Manufacturer must make a selection based on support (Aftg) for gravity loads and Anchorage (Av) for lateral loading. Guidance is provided about the suitability of each choice given a site that must consider deep frost, high winds or high seismic zone. Color coding is used to help the User select a foundation option. Red means unsuitable, yellow is cautionary but possible, and green is definitely suitable. For additional assistance in  selection of the correct Foundation Design Concept, choose the Appendix A button to view the On-Line “Handbook” text and details. Foundation Type is given a Symbol, i.e. C1 to C4 and E1 are shown on the portion of the illustration below. Select the desired foundation type by clicking the left mouse key when the pointer is over the box chosen. Click on OK after the choice has been highlighted across the row.
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	Click the left mouse key with the pointer over the right side box of question #3. 





D.	The Superstructure Dimensions dialog window will appear consistent with the answer to question #1, in this case a single-section unit will appear as shown below.





�





	The Manufacturer may type in the appropriate dimensions for each open box, or use the scroll down feature of standard dimensions. Click on OK when satisfied with the choices and they will automatically be placed in the open boxes of questions #3 through #10, excluding question #8, regarding the weight of the unit, where a number most likely will be typed in.





E.	The remaining portion of the Manufacturer’s Worksheet is found by scrolling down on the right side vertical bar. The boxes to the right side of the questions will bring up additional dialog windows, i.e. the Recommended Pier Spacing dialog window, and others. This is a sufficient introduction to illustrate the use of the features of the Manufacturer’s Worksheet. 





Design Worksheet: The Design Worksheet collects all the data necessary to complete the design of a permanent foundation type and selection of all the connection details. It uses information from the two previous Worksheets, and the output from the Geometry and Loads dialog windows, and interacts with the on-line Appendix C (Foundation Capacities Tables) from the “Handbook”. Thus it permits final selection of the following items:





A.	Selection of spacing, depth, and size of footings based on soil bearing capacity and frost protection.





B.	Selection of size, spacing and quantity of anchors to resist pullout under an overturning situation due to wind and/or seismic forces. 





C.	Selection of the method, size, spacing and quantity of anchors to resist sliding in the transverse direction, and





D.	Selection of the method, size, spacing and quantity of anchors to resist sliding in the longitudinal direction.





The Design Worksheet is selected from the Worksheets pull-down menu. Notice that it is separated into sections that match sections in the “Handbook” to make it easier to use. The pull-down is shown below:
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The Design Worksheet will have answers already filled in to questions previously answered on the other two Worksheets. Also, a box is located to the right of each question, whether filled in or not, to return to the dialog window where the decisions were made to permit any final changes the User may wish to make. The window layout is similar to the other Worksheets and Chapter 5 will further elaborate during the solution of an example problem.


Design


The Design pull-down menu contains the commands that contain dialog windows of information, such as load summaries, and solve the equations that provide the required forces for design. They include the following dialog windows: 


Gravity Load Footing Size


Overturning


Transverse Sliding


Longitudinal Sliding


The manipulation of  the variables in these dialog windows, helps the User to arrive at realistic foundation bearing and anchorage forces, which are automatically input into the Design Worksheet.  


Window


The Window pull-down menu contains the current list of open windows, and affords the User commands regarding the display of the windows, and lastly the arrangement of the Icons. The pull-down menu looks as follows:
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Help


The Help pull-down menu contains the following commands: 


The Guide: 	Which is an easy way to access the On-Line “Handbook”. 


Help Topics: Provides help for use of the program.	


About PFGMH:	Shows the User the version number of the program, the available physical memory in KB, and the free disc space on the hard drive.


Main Tool Bar


The Main Tool Bar is illustrated below. It contains a series of icons that are commands just like those found in the Pull-down Menus. Placing the mouse pointer on any one of the icons brings up a Tool Tip telling you what the icon does. For example the icon that looks like a diskette is the “Save” command that would be found in the File pull-down menu. Once the User becomes familiar with the icons they become a faster way to activate a command. All the names of the Icon Commands are listed below. All the commands will be used during the solution of Example #1 and Example #2, except the Context Help command, which when activated will provide help on the next selected command with the mouse pointer and clicking the left mouse key. Note the “question mark” follow the mouse pointer to the next command.
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Status Bar


The Status Bar located in the lower left part of the open window. It tells you what a selected command will do, it also prompts you as operations are being performed.
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